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Introduction
These release notes describe caveats, known bugs, and other important information for installing and 
using MWTM 6.0.1.

What’s New in MWTM 6.0.1
The MWTM 6.0.1 release provides these new features:

Feature Description

Indicator to show if RAN 
traffic is optimized or not

A new Optimized column appears when you select a RAN backhaul in 
the navigation tree and click the RAN Shorthauls tab. Yes indicates that 
the traffic on the shorthaul is optimized; No indicates the traffic is not 
optimized.

Support for asymmetric 
backhaul interface speed

Related to CSCsg62928 (now resolved), the RAN-O backhaul 
performance charts now correctly show % Utilization when the 
backhaul contains interfaces that have asymmetric link speeds.

Support for nodes:

• Content Services 
Gateway (CSG) and 
CSG2

• GPRS Gateway Support 
Node (GGSN)

• Generic devices

MWTM 6.0.1 enables you to discover and manage traps and alarms for 
CSG, CSG2, and GGSN nodes. 

The MWTM also supports integration with release 4.1.2 of the CSG 
and GGSN Service Managers. Once integrated, you can launch these 
service managers from the MWTM Tools menu to provision CSG, 
CSG2, and GGSN devices.

This feature also provides server-side integration of CiscoWorks (by 
setting preferences in the GUI or the command line interface (CLI). 
You can configure the MWTM personality to manage CSG, CSG2, or 
GGSN networks, or all three (in addition to existing personality types). 
For more information, see CLI Updates, page 5.

The MWTM can also discover generic devices, including non-Cisco 
devices, as long as they have the RFC-1213-MIB.

Support for new ITP software 
releases 

• 12.2(18)IXD

• 12.2(25)SW9

• 12.2(25)SW10

• 12.4(11)SW1 and 12.4(11)SW2

Support for new RAN-O 
software releases

•  12.4(12)MR and 12.4(12)MR1 on the MWR

• 12.2(29)SM1 on the ONS RAN SVC card
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Installing the MWTM 6.0.1 Patch
The following MWTM 6.0.1 build files are available:

• Solaris—mwtm601-sol-<date>-patch-k9.zip

• Linux—mwtm601-linux-<date>-patch-k9.zip

For instructions on how to install the MWTM 6.0.1 patch build, refer to the MWTM 6.0.1 Patch Readme 
file included with the MWTM 6.0.1 patch at the software download site:

http://www.cisco.com/cgi-bin/tablebuild.pl/MWTM-3D

Limitations and Restrictions
This section describes limitations and restrictions that are associated with the MWTM.

Provisioning Timeout
When using the MWTM provisioning feature to modify the management interface, sometimes the 
operation fails with this message:

No prompt response

This response can occur when changing the duplex or speed attributes for the Ethernet interface. The 
response can also occur for other interface attributes that affect IP connectivity between the MWTM and 
the device.

The default setting for a provisioning operation timeout is 50 seconds. As a workaround, the system 
administrator can increase the TGS_OP_TIMEOUT attribute in the System.properties file to a higher 
value. You must restart the MWTM server for this change to take effect.

SSH-Enabled Nodes
The MWTM Node > Home Page right-click menu option does not work correctly for the following 
SSH-enabled IP Transfer Point (ITP) nodes:

• Cisco 2600

• Cisco 7200

• Cisco 7300

• Cisco 7500

• Cisco 7600

The browser launches, as expected, but the user is not prompted for login information.

Note This limitation exists for any ITP node running the 12.2(x) IOS with SSH enabled.
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INSTANCE_NUMBER on Single-Instance ITP

Symptom If a command with INSTANCE_NUMBER is included in the UserCommands.ts file, the 
instance number will appear on all nodes in the GUI. If you run this command on a node that does not 
have multi-instance enabled, it fails. 

Workaround If you have a network with both single-instance and multi-instance nodes, you must 
configure a separate set of troubleshooting commands for each node type in the UserCommands.ts file. 
Do this by grouping the commands for each type under a separate category.

Multi-processor Multithread Vendor Exception
Sometimes when using the MWTM client on a Solaris multi-processor computer, an exception occurs 
when the topology window is open and you are manipulating views. The workaround is to close the 
topology window, then reopen it.

External SSH Client Use
If you enable the MWTM terminal proxy (mwtm termproxy) and use an external SSH terminal client 
to connect to a device, you might receive a warning message indicating a man-in-the-middle attack.  This 
warning occurs because the MWTM server is operating as an SSH proxy to the device. In this scenario, 
ignore any warning messages indicating a man-in-the-middle attack.  These warnings do not occur if you 
disable the MWTM terminal proxy or if you use the SSH terminal included with the MWTM.

Important Notes
This section contains important notes about:

• RAN Backhaul Utilization, page 4

• CLI Updates, page 5

RAN Backhaul Utilization
When the backhaul utilization for transmit traffic exceeds 100%, the likely cause is oversubscription of 
the shorthaul links that constitute the backhaul. The backhaul utilization is the amount of traffic that the 
system attempted to send, not the amount that was actually sent.  If utilization is greater than 100%, you 
should see queue drops or other errors during the same time period. A backhaul utilization of greater 
than 100% is possible for a heavily loaded link with some occasional oversubscription.
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CLI Updates
To enable support of CSG, CSG2, and GGSN nodes and integration of the CSG and GGSN Service 
Managers, MWTM 6.0.1 contains these important updates to the CLI:

• mwtm importcw, page 5

• mwtm manage, page 5

• mwtm snmpsetup, page 6

• mwtm cwsetup, page 6

mwtm importcw

Full Syntax

mwtm importcw [cwfile] 

Command Description

Imports node hostname and read-community strings from the CiscoWorks server to the MWTM.

cwfile—File name of the CiscoWorks export file (for example, /tmp/export.txt). The export file must be 
in CSV file format.

You must log in as the root user or superuser to use this command. You do not need to restart the server 
to activate this command. After running this command, the MWTM discovers the imported nodes.

mwtm manage

Full Syntax

mwtm manage [itp | ran-o | csg | csg2 | ggsn] [ enable | disable | status] 

Command Description

Enables, disables, or checks the status of managed networks:

• itp, ran-o, csg, csg2, or ggsn—Type of network (or personality).

• disable—Disables the MWTM from managing the selected network.

• enable—Enables the MWTM to manage the selected networks.

• status—Displays the status of networks (whether enabled or disabled).

You must log in as the root user or superuser to use this command.

You must restart the MWTM server for your changes to take effect.
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mwtm snmpsetup

Full Syntax

mwtm snmpsetup

Command Description

Sets up SNMP configurations on the MWTM server for multiple devices and optionally discovers the 
new nodes. This command interactively prompts you to add, modify, or delete one or more SNMP 
configurations, which include values for:

• Hostname

• Read community string

• Poll interval (in minutes)

• Timeout (in seconds)

• Number of retries

When modifying poll interval, retry, and timeout values, this command displays the currently available 
value in brackets ([ ]). When adding new SNMP configurations, this command displays default values.

After adding, modifying, or deleting an SNMP configuration, this command prompts you to discover the 
node (only this node is discovered).

You do not need to restart the server when using this command.

mwtm cwsetup

Full Syntax

mwtm cwsetup [install | uninstall]

Command Description

Manages the integration of the MWTM with CiscoWorks:

• install—Checks to see which CiscoWorks files are installed and installs additional files as 
necessary. Use this command to integrate the MWTM and CiscoWorks in these instances:

– You installed CiscoWorks after you installed the MWTM.

– The MWTM and CiscoWorks are no longer integrated for some reason.

• uninstall—Removes MWTM files from the CiscoWorks area.

Note Always run mwtm cwsetup uninstall before uninstalling CiscoWorks from your system.

• If you do not enter a keyword (install or uninstall), the command prompts you to enter the:

– CiscoWorks server name

– Port number for the CiscoWorks web server (the default setting is 1741)

– Secure port number for the CiscoWorks web server (the default setting is 443)
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Note Changing CiscoWorks settings by using the mwtm cwsetup command sets all clients on the 
MWTM server to use these settings. You can configure a particular MWTM client to use 
different CiscoWorks settings by changing the client’s preferences (see the User Guide for 
the Cisco Mobile Wireless Transport Manager 6.0).

You must log in as the root user (not as a superuser) to use this command.

You must restart the MWTM server for your changes to take effect.

Resolved MWTM Caveats
The following bugs have been fixed in MWTM 6.0.1:

Bug ID Description

CSCsb71124 Need the capability to change CiscoWorks server settings in the GUI.

CSCsc91157 Support for CSG, CSG2, GGSN 6/7, and generic nodes.

CSCsh90827 

CSCsh90848

CSCsh98352 

CSCsh98358 

CSCsh98345 

CSCse42623 Need a CLI command to collect customer data within a specified date range.

CSCse63925 Node status in the navigation tree and node status in the Details tab should match 
when the server sends node status updates.

CSCse64933 Notify the user if the server shuts down and then ping the server for reconnection.

CSCsg23171 Add an SSH proxy capability to the MWTM.

CSCsg62928 The RAN-O backhaul performance charts can show incorrect % utilization (Y axis, 
on the right side of the chart) when the backhaul has interfaces with asymmetric link 
speeds or different physical interfaces for send and receive traffic.

CSCsh67907 Support the latest MLR table file format in the address table editor.

CSCsh71221 A web client user cannot change user login password.

CSCsh71843 The Management Information Base (MIB) ifTable does not contain T1/E1 controllers 
for the T1/E1 controllers on the Cisco 2600 WIC card. (Fixed in 12.4(11)SW1.)

CSCsh74030 Allow the user to add variables when setting external Telnet/SSH clients.

CSCsh86628 Update the client download page with the new template.

CSCsh86678 Support for the MWR IOS 12.4(12)MR1.

CSCsh89439 Loading the GTT table from an ITP may fail because the ITP network name contains 
a space ( ) character.

CSCsh89933 The RAN-O Error Stats report shows a minor mismatch caused by rounding errors.

CSCsh90549 Add peak utilization data to the RAN-O backhaul and shorthaul performance reports.

CSCsh90856 Support link flapping detection intelligence in trap processing.
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CSCsh93171 Add the ability to delete, change the severity of, acknowledge, or unacknowledge 
events; access help for events; and show properties and/or time differences for events.

CSCsh96754 The console log on a server-only install has grep errors in the System.properties file.

CSCsh98349 Service Manager integration for CSG, CSG2, and GGSN nodes.

CSCsi01991 Activation of route, GTT, or address table files needs to handle message.

CSCsi02009 NULL GTA value should appear as default in ITP report.

CSCsi03627 The command show tac is canceled when you run General > System Information 
using MWTM web troubleshooting.

CSCsi07242 Allow the user to modify community strings using a new CLI and without restarting 
the MWTM server (for details on the new commands, see mwtm snmpsetup, page 6 
and mwtm importcw, page 5).

CSCsi07435 Exception while deleting a RAN backhaul node.

CSCsi07499 A RAN SVC card that is associated with other objects reappears in the navigation tree 
after being deleted.

CSCsh91440 RAN-O: Add support for optimized/non-optimized flag in MIB.

CSCsi08802 

CSCsi08813 

CSCsi08817 

CSCsi10309 RANO: Asymmetric backhaul support.

CSCsi10310 

CSCsi10316 

CSCsi10319 

CSCsi24053

CSCsi12057 Fix captions in the Event Properties dialog box.

CSCsi12075 Allow users to pause or force a page refresh.

CSCsi12076 Allow users to show/hide columns in the events page in the MWTM web client.

CSCsi14351 Allow user to edit notes in the MWTM web client.

CSCsi15506 Add support for 72xx devices with an NPE-G2 processor.

CSCsi20826 RAN backhaul sent and received utilization events should raise an alarm.

CSCsi24036 Utilization summary reports do not always aggregate all real backhauls in a virtual 
backhaul.

CSCsi24542 The Change By field for events is not persistent. The field was removed.

CSCsi31053 Synchronize the selected tab when the user clicks the browser’s back button.

CSCsi31128 Support for 12.2(18)IXD.

CSCsi31138 Support for 12.2(25)SW10.

CSCsi31145 Support for 12.4(11)SW2.

CSCsi32571 Lose the ability to show the Node column when the ITP personality is disabled.

CSCsi33005 Show/Hide columns for all MWTM web tables (like the events table).

CSCsi50364 Display help messages for CLI commands based on personality.

Bug ID Description
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CSCsi52212 Switching object in tree causes tab to change.

CSCsi55840 In the Events GUI, add delete menu items to the event popup menu and toolbar.

CSCsi58463 A basic user should not have access to view real-time data and charts.

CSCsi58967 A basic user should not have access to the options within the View > MWTM Server 
> Connect menu.

CSCsi62204 A network administrator should not have access to perm.mana.node.

CSCsi62211 The topology window Edit > Delete option should be dimmed for BTS, BCS, 
Node_B, and RNC nodes.

CSCsi65571 When you select a node in the navigation tree of the web or MWTM client, and select 
the Status Contributors tab, an extraneous User Items folder appears in the table.

CSCsi65923 Add support for 12.2(29)SM1 on ONS-RAN-SVC.

CSCsi70809 Popup menu links for Performance History and Error History are incorrect.

CSCsi72180 Web client and Java client need consistency when clicking objects.

CSCsi72193 Changing name for an ITP signaling point should also change the MWTM web client 
name.

CSCsi74057 Frequently clicking MWTM web client tabs in Microsoft Internet Explorer 
sometimes takes you to the MWTM web login page.

CSCsi74092 Re-login inside some web tabs shows a “file not found” error.

CSCsi75330 There is a mismatch between the MWTM client and the MWTM web regarding the 
application server process assocation name in the Details tab.

CSCsi75395 Deleting a backhaul from a virtual backhaul leaves the virtual backhaul in an 
incorrect state.

CSCsi77640 Remove sorting from point code and IP address tables in web.

CSCsi82707 Give more information for the mwtm secondary server list command.

CSCsi85815 If the user changes bandwidth settings on a RAN backhaul, these changes are not 
reflected in the database.

CSCsi91353 Exception thrown to client console.

CSCsi93555 Deleting a seed file causes a nullPointerException.

CSCsi95182 HSRP traps do not trigger node polling immediately after switchover of HSRP nodes 
during manual polling.

CSCsj03930 On an ITP node running 12.4(11)SW2 or later, if you try to load address tables, or if 
you click the MTP3 Errors tab, you receive an error message that says, “MIB not 
compliant.”

CSCsi76418 Installing the 6.0.1 patch creates a patch log in /var/tmp and in /opt/CSCOsgm/install.

Bug ID Description
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Open MWTM Caveats
This section describes caveats that exist in the MWTM 6.0.1 software.

• CSCse81393

Symptom In various GUI and web pages, simple text fields might contain unprintable characters. An 
example is the Model Name PID field for a RAN service (RAN_SVC) card in an ONS chassis.

Conditions Some RAN_SVC cards in an ONS chassis can exhibit this behavior.

Workaround None. This is a cosmetic problem and does not affect functionality.

• CSCsg83861

Symptom The preferences dialog box of the MWTM client interface allows you to customize the way 
that data series appear in charts. You can specify series color, line style, and symbol style. However, 
symbol style and line style preferences do not work when displaying real-time charts for MSU rates and 
for RAN backhauls and shorthauls.

Workaround None.

• CSCsg92892 

Symptom When provisioning ITP nodes from the Provision tab of the web interface, some provisioning 
operations might fail on the node with these symptoms and conditions:

Provisioning Action Symptom Condition

Changing the media 
type for FastEthernet 
or GigabitEthernet 
interface

Invalid input 
detected

FastEthernet or GigabitEthernet on the node does not 
support the media type configuration option, but the 
user specified a media type in the MWTM 
provisioning request.

Changing speed for 
FastEthernet or 
GigabitEthernet 
interface

Invalid input 
detected

FastEthernet or GigabitEthernet on the node does not 
support the speed configuration option, but the user 
specified the speed in the MWTM provisioning 
request.

Configuring MTP3 
User Adaptation 
(M3UA) or SCCP 
User Adaptation 
(SUA) offload, or 
Local Peer offload

Error: at least one 
address must reside 
on slot xx

The user specified an IP address that does not exist for 
the specified card slot.
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Workaround None. The user must know the ITP card information and specify correct values in the 
provisioning request.

• CSCsh00145 

Symptom Credentials for a node are associated with a unique IP address. If a node has more than one 
accessible IP address, functions that require credentials might not resolve to a credential based on the 
selected IP address, and the requested function would fail. The MWTM functions that require credentials 
include:

• Discovery of ONS and RAN_SVC nodes

• Troubleshooting

• Provisioning

• Route and Global Title Translation (GTT) table deployment

Conditions Nodes with multiple, accessible IP addresses with credentials set for a subset of those IP 
addresses.

Workaround Specify credentials for all accessible IP addresses for a node.

Configuring M3UA 
or SUA offload, or 
Local Peer offload

Error: XXX is 
already offloaded 
to this linecard 
slot=xx

The user specified a target card slot that is already in 
use by another M3UA or SUA offload, or Local Peer 
offload.

Note The ITP does not allow mixed types between 
M3UA or SUA offload, and Local Peer offload. 

Configuring the line 
priority for the clock 
source line option on 
the Cisco 2600 T1/E1 
controller 

% Invalid input 
detected at '^' 
marker.

The '^' marker points 
to the line priority: 
primary or secondary.

While configuring the clock source line priority option 
on the T1/E1 controller, the user specified the primary 
or secondary option on the line, but the WAN Interface 
Card (WIC) card has only one port, and does not 
support the line priority option.

Configuring the 
secondary line 
priority for the clock 
source line option on 
the Cisco 7xxx ITP 
T1/E1 controller

% Invalid input 
detected at '^' 
marker.

The '^' marker points 
to the secondary line 
priority: primary or 
secondary.

When configuring the clock source secondary line 
priority option on the T1/E1 controller, the user 
specified a number that is greater than the supported 
range on the device. Although the MWTM allows 
values 1-72, some cards only support 1-8 or 1-16.

Provisioning Action Symptom Condition
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• CSCsh15638 

Symptom The following exception with corresponding stacktrace can occur. The MWTM captures this 
exception in the sgmConsoleLog.txt file:

java.net.SocketException: Broken pipe

Conditions This exception can occur when users access the MWTM web interface and frequently abort 
connections while the server is under heavy load (for example, during discovery). Clicking the Stop 
button on the web browser or navigating to a different web page before the current page finishes loading 
can cause this exception to occur.

Note The root cause of this condition is an internal bug in the Tomcat web application that ships with 
this release of the MWTM. 

Workaround None, but you can safely ignore these log messages.

• CSCsh58070

Symptom The following error messages may appear when performing these operations:

Conditions The error messages occur when ITP linkset, AS, and ASP names contain a colon (:).

Workaround Remove the colon (:) from ITP linkset, AS, and ASP names.

Operation Error Message

Generating link report by using the 
sgmLinkStats.sh script

sgmgawk: cmd. line:45: (FILENAME=- FNR=???) 
fatal: division by zero

Attempting to import link and linkset report 
data

ERROR 38000: The exception 
'java.sql.SQLException: Invalid character 
string format for type SMALLINT.' was thrown 
while evaluating an expression.

Using the ITP route table deployment 
function

Invalid Linkset in Route Table: [???]
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• CSCsi68842

Symptom Negative numbers appear in the Error counts table for RAN shorthauls and backhauls.

Workaround None.

• CSCsi94803

Symptom A network address or broadcast address is discovered by the MWTM and treated as a node 
because an SNMP response is received when a request is sent to that address. About every 15 minutes, 
the node state switches between Unknown and Active, or between Unknown and Warning. When the 
node state is Unknown, the state reason shows SNMP MIB Data Error.

Workaround Open the Java client, select the invalid node representing the network address or broadcast 
address in the tree, right-click it, and delete it. Verify that the other discovered nodes have correct SNMP 
polling addresses by right-clicking on a node, selecting Edit > SNMP IP Addresses, and confirming the 
appropriate SNMP IP address is in the list of IP addresses on the right side of the panel.

• CSCsj02446 

Symptom When the CiscoWorks server uses non-default settings on SSL and/or other ports, the Device 
Center and CiscoView links are broken when the CiscoWorks server is set to allow only SSL, and a 
“Forbidden” message appears. Also, the Service Manager links always go to the CiscoWorks main pages 
instead of the Service Manager main pages.

Workaround Go to the CiscoWorks page manually, or use the default settings on the CiscoWorks server.

Open Device Caveats
This section documents caveats associated with the devices that the MWTM manages. These caveats can 
affect the capability of the MWTM to manage the associated features. Follow the guidelines in the 
workarounds for these defects.

• CSCse13374 

Symptom When you configure the clock source on an ITP 7600 IMA interface to a non-default value, if 
the ITP 7600 reboots, the clock source reverts to the default value, “line”.

Workaround Re-apply the clock source on all the IMA interfaces after the ITP 7600 reboots.
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• CSCsg76526

Symptom When you unconfigure Preventive Cyclic Retransmission (PCR) from an MTP2 link on an ITP 
device, the device incorrectly retains tuning parameters, such as n1 and n2, in the running configuration.

Conditions You configure PCR and set tuning parameters with values other than default values.

Workaround Unconfigure the tuned parameter first. Then, unconfigure PCR.

• CSCsg77134

Symptom When you unconfigure a tuned parameter for a link that belongs to a linkset with a configured 
profile, the default value for the timer is incorrectly restored instead of the profile timer value.

Conditions The cs7 profile is overriding the profile value.

Workaround Unconfigure and reconfigure the profile for the linkset. This action should restore the 
profile value to all links.

• CSCsg77152

Symptom When you configure the following parameter for an SCTP link:

 retransmit-cwnd-rate <rate> sctp-fast-retransmit

the sctp-fast-retransmit portion is not saved in the configuration, and is ignored at the next reload.

Conditions Tune the sctp-fast-retransmit parameter for retransmit-cwnd-rate.

Workaround Reconfigure the parameter after reloading the device.

• CSCsh13017

Symptom The MWTM login credentials might not work if you run the no enable secret command on the 
active RAN Service (RAN SVC) Module.

Conditions During failover, the running configuration on the active RAN service card merges with the 
RAN protection card. As a result, any baseline configuration command that exists on the protection card 
but not on the active card will be applied. 

Workaround For all RAN service cards:
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• Apply the enable-secret configuration option.

• Define these credentials in the MWTM.
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Related Documentation
Use this document in conjunction with the following documents:

• Installation Guide for the Cisco Mobile Wireless Transport Manager 6.0

• User Guide for the Cisco Mobile Wireless Transport Manager 6.0

• OSS Integration Guide for the Cisco Mobile Wireless Transport Manager 6.0

Obtaining Documentation, Obtaining Support, and Security 
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, 
security guidelines, and also recommended aliases and general Cisco documents, see the monthly 
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

This document is to be used in conjunction with the documents listed in the “Related Documentation” section.

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.
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